Important Digital Imaging Terms to Know and Understand

For Introductory Study:
Pixel




Pixel - The picture elements that make up the images you see.

Picture element; a pixel is the smallest display element that makes up the images you see on a computer monitor or television. A typical image contains millions of pixels which is why digital camera output is defined in megapixels (mega=millions). In bitmap -based images, the more pixels an image contains, the higher its resolution. 

This example is a computer icon with original dimensions of 32 by 32 pixels. The larger image shows the icon zoomed to 500% so you can clearly see the individual pixels in the image. A single pixel is indicated by a red outline in the upper right-hand corner

Vector and Bitmap Images

Two Types of 2D Graphics




A Bitmap Image--shown zoomed in with the original size in the upper right corner. Notice the individual pixels that make up the image.

It's almost impossible to discuss graphics software without first establishing an understanding of the differences between the two major 2D graphic types: bitmap and vector images. This is an important lesson and often a tough one to grasp. If you work with graphics at all, it's bound to come up, so it's an important concept to understand. Let's start by talking about the more common type: bitmap images. 

Bitmap and Raster
A bitmap (or raster) image is one of the two major graphic types (the other being vector ). Bitmap-based images are comprised of pixels in a grid. Each pixel or "bit" in the image contains information about the color to be displayed. Bitmap images have a fixed resolution and cannot be resized without losing image quality. Common bitmap-based formats are JPEG, GIF, TIFF, PNG, PICT, and BMP. Most bitmap images can be converted to other bitmap-based formats very easily. Bitmap images tend to have much large file sizes than vector graphics and they are often compressed to reduce their size. Although many graphics formats are bitmap-based, bitmap (BMP) is also a graphic format. 
Facts About Bitmap Images

Bitmap images (also known as raster images) are made up of pixels in a grid. Pixels are picture elements; tiny dots of individual color that make up what you see on your screen. All these tiny dots of color come together to form the images you see. Most computer monitors display approximately 70 to 100 pixels per inch--the actual number depends on your monitor and screen settings. 

To illustrate this, let's take a look at a typical desktop icon such as the one shown in the image here. The icons on your desktop are typically 32 by 32 pixels. In other words, there are 32 dots of color going in each direction. When combined, these tiny dots form an image. The icon shown in the upper right corner of this example is a typical desktop icon at screen resolution. As you can see, when you enlarge the icon, as I have in this example, you can clearly see each individual square dot of color. Note the that white areas of the background are still individual pixels, even though they appear to be one solid color. 

Bitmap images are resolution dependent. Resolution refers to the number of pixels in an image and is usually stated as dpi (dots per inch) or ppi (pixels per inch). Bitmap images are displayed on your computer screen at screen resolution: approximately 100 ppi. However, when printing bitmaps, your printer needs much more image data than a monitor. In order to render a bitmap image accurately, the typical desktop printer needs 150-300 ppi. If you've ever wondered why your 300 dpi scanned image appears so much larger on your monitor, this is why. For more in-depth information about resolution, scanning, and printing bitmap images, refer to my article Getting Started Scanning. 

Because bitmaps are resolution dependent, it's difficult to increase or decrease their size without sacrificing a degree of image quality. When you reduce the size of a bitmap image through your software's resample or resize command, you must throw away pixels. When you increase the size of a bitmap image through your software's resample or resize command, the software has to create new pixels. When creating pixels, the software must estimate the color values of the new pixels based on the surrounding pixels. This process is called interpolation. 

Did you notice in the paragraph above, I specifically talked about resizing images "through your software's resample or resize command"? I want to make the distinction between this method of resizing versus zooming in and out, or dragging the edges of your images in a page layout program to resize it. This type of resizing is more accurately called scaling. Scaling an image does not effect the image permanently. In other words, it does not change the number of pixels in the image. However, if you scale a bitmap image to a larger size in your page layout software, you are going to see a definite jagged appearance. Even if you don't see it on your screen, it will be very apparent in the printed image. Scaling a bitmap image to a smaller size doesn't have any effect; in fact, when you do this you are effectively increasing the ppi of the image so that it will print clearer. 

Common bitmap formats include: 
• BMP 
• GIF 
• JPEG, JPG 
• PNG 
• PICT (Macintosh) 
• PCX 
• TIFF 
• PSD (Adobe Photoshop) 

Popular bitmap editing programs are: 
• Microsoft Paint 
• Adobe Photoshop 
• Corel Photo-Paint 
• Corel Paint Shop Pro 
• The GIMP 

All scanned images are bitmaps, and all images from digital cameras are bitmaps. 

Converting between bitmap formats is generally as simple as opening the image to be converted and using your software's Save As... command to save it in any other bitmap format supported by your software. 

Bitmap images in general do not inherently support transparency. A couple of specific formats--namely GIF and PNG--support transparency. In addition, most image editing programs support transparency, but only when the image is saved in the software program's native format. A common misconception is that the transparent areas in an image will remain transparent when an image is saved to another format or copied and pasted into another program. That just doesn't work; however, there are techniques for hiding or blocking out areas in a bitmap that you intend to use in other software. For more information about retaining transparency in bitmap images, see Transparency from Here to There. 

Key Points About Bitmap Images: 
• pixels in a grid 
• resolution dependent 
• resizing reduces quality 
• easily converted 
• restricted to rectangle 
• minimal support for transparency 

Vector Images

Vector 
A vector image is one of the two major graphic types (the other being bitmap). Vector graphics are made up of many individual objects. Each of these objects can be defined by mathematical statements and has individual properties assigned to it such as color, fill, and outline. Vector graphics are resolution independent because they can be output to the highest quality at any scale. 

Software used to create vector graphics is sometimes referred to as object-based editing software. Common vector formats include AI (Adobe Illustrator), CDR (CorelDRAW), CGM (Computer Graphics Metafile), SWF (Shockwave Flash), and DXF (AutoCAD and other CAD software). Vector graphics tend to have much smaller file sizes than raster-based bitmaps.

Vector images are resolution independent. Currently, the only way vector images can be displayed on the Web is by requiring viewers to install a browser plug-in.

Although not as commonly used as bitmap graphics, vector graphics have a lot of virtues. Let's explore them now. 

Vector images are made up of many individual, scalable objects. These objects are defined by mathematical equations rather than pixels, so they always render at the highest quality. Objects may consist of lines, curves, and shapes with editable attributes such as color, fill, and outline. Changing the attributes of a vector object does not effect the object itself. You can freely change any number of object attributes without destroying the basic object. An object can be modified not only by changing its attributes, but also by shaping and transforming it using nodes and control handles. Because they're scalable, vector-based images are resolution independent. You can increase and decrease the size of vector images to any degree and your lines will remain crisp and sharp, both on screen and in print. Fonts are a type of vector object. 

Another advantage of vector images is that they're not restricted to a rectangular shape like bitmaps. Vector objects can be placed over other objects, and the object below will show through. See the example images on this page. The vector circle and bitmap circle appear to be exactly the same when seen on a white background. But when you place the bitmap circle over another color, it has a rectangular box around it, from the white pixels in the image. 

Vector images have many advantages, but the primary disadvantage is that they're unsuitable for producing photo-realistic imagery. Vector images are usually made up of solid areas of color or gradients, but they cannot depict the continuous subtle tones of a photograph. That's why most of the vector images you see tend to have a cartoon-like appearance. Even so, vector graphics are continually becoming more advanced, and we can do a lot more with vector drawings now than we could a decade ago. Today's vector tools allow you to apply bitmapped textures to objects giving them a photo-realistic appearance, and you can now create soft blends, transparency, and shading that once was difficult to achieve in vector drawing programs. 

Vector images primarily originate from software. The most common reason for wanting to convert a vector to a bitmap would be for use on the Web. At this time, the most common and accepted format for vector images on the Web is Shockwave Flash (SWF). Another standard for vector images on the Web is SVG, a graphics programming language based on XML. Due to the nature of vector images, they are best converted to GIF or PNG format for use on the Web. 

Common vector formats include: 
• AI (Adobe Illustrator) 
• CDR (CorelDRAW) 
• CMX (Corel Exchange) 
• CGM Computer Graphics Metafile 
• DXF AutoCAD 
• WMF Windows Metafile 

Popular vector drawing programs are: 
• Adobe Illustrator 
• CorelDRAW 
• Xara Xtreme 
• Serif DrawPlus 
Key Points About Vector Images 
• scalable 
• resolution independent 
• no background 
• cartoon-like 
• inappropriate for photo-realistic images 
• metafiles contain both raster and vector data 

PPI - Pixels Per Inch
PPI stands for pixels per inch. PPI is a measurement of image resolution that defines the size an image will print. An image that is 1600 by 1200 pixels at 300ppi will print at a size of 5.3 by 4 inches. Or it could be printed at 180 ppi for a printed size of 8.89 by 6.67 inches. The higher the ppi value, the better quality print you will get--but only up to a point. 300ppi is generally considered the point of diminishing returns when it comes to ink jet printing of digital photos. 
The term DPI is often used interchangeably with PPI, causing a lot of confusion; however, DPI refers to the resolution of a printing device. 
DPI or Dots per Inch
DPI stands for dots per inch. DPI is a measurement of printer resolution that defines how many dots of ink are placed on the page when the image is printed. DPI does not correspond directly with PPI because a printer may put down several dots to reproduce one pixel. This is because printers use a limited number of colored inks to reproduce an image consisting of millions of colors. The higher a printer's DPI, the smoother your printed image will appear, provided you have a suitable amount of image resolution (ppi). 

Today's photo-quality ink jet printers have DPI resolution in the thousands (1200 to 4800 dpi). They will give you acceptable quality photo prints of images with 140-200 ppi resolution, and high quality prints of images with 200-300 ppi resolution. 

The term DPI is often used interchangeably with PPI, causing a lot of confusion, however, DPI refers to the resolution of the printing device, where PPI refers to the resolution of the image itself. 

Resolution
Resolution is a measurement of the output quality of an image, usually in terms of samples, pixels, dots, or lines per inch. The terminology varies according to the intended output device. PPI (pixels per inch) refers to screen resolution, DPI (dots per inch) refers to print resolution, SPI (samples per inch) refers to scanning resolution, and LPI (lines per inch) refers to halftone resolution. 
Often images are referred to as high resolution (hi-res) or low resolution (low-res). High resolution would be an image intended for print, generally having 300 samples per inch or more. Low resolution refers to images only intended for screen display, generally having 100 pixels per inch or less. 

Scanner and digital camera manufacturers often refer to two different types of resolution when listing product specs: optical resolution and interpolated, or digital, resolution. The optical resolution is the true measurement of resolution that the output device can capture. Interpolated, or digital, resolution is acquired artificially. 

Increasing Image Resolution
One of the most commonly asked questions in relation to graphics software is how to increase the size of an image without getting blurring and jagged edges. New users are often surprised when they resize an image and find that the quality is severely degraded. Experienced users are all too familiar with the problem. The reason for the degradation is because bitmapped, or raster, image types are limited by their pixel resolution. When you attempt to resize these types of images, your software either has to increase the size of each individual pixel - resulting in a jagged image - or it has to "guess" at the best way to add pixels to the image to make it larger.
Resizing vs. Resampling
Most software only has one command for both resizing and resampling. Resizing an image involves changing the print dimensions without changing the total pixel dimensions. As the resolution is increased, the print size becomes smaller, and vice versa. When you increase resolution without changing pixel dimensions, there is no loss in quality, but you must sacrifice print size. Resizing an image using resampling, however, involves changing the pixel dimensions and will always introduce a loss in quality. That's because resampling uses a process called interpolation for increasing the size of an image. The interpolation process estimates the values of the pixels the software needs to create based on the existing pixels in the image. Resampling via interpolation results in serious blurring of the resized image, especially in areas where there are sharp lines and distinct changes in color.
• About Image Size & Resolution 
Interpolation
To estimate values between two known values. In regard to graphics software, interpolation is a process where the software adds new pixels to an image based on the color values of the surrounding pixels. Interpolation is used when an image is upsampled to increase its resolution. Resampling through interpolation is not ideal and often results in a blurry image. 
In reference to scanner and digital camera specifications, the interpolated resolution is often listed along with the device's optical resolution. In this situation, the optical resolution is the true measurement of what can be captured and the interpolated resolution should be disregarded as a purchasing factor. 
Common Interpolation Methods
• Photoshop's Image Size Dialog Box
Photo editing software generally offers a few different interpolation methods for calculating new pixels when an image us upsampled. Here are descriptions of the three methods available in Photoshop.  Under image, image size:
· Bicubic is the slowest but produces the best estimation of new pixel values. 

· Bilinear is faster than bicubic, but does a poorer job. Both bicubic and bilinear interpolation result in a blurred image, especially when upsampling. 

· Nearest Neighbor doesn't use interpolation. It simply takes the value of the neighboring pixels and adds new pixels without averaging them. This is when you get the jaggies or stair-step effect.

Note that there are more than just these three methods of interpolation and even using the same method in different software may produce different results. In my experience, I have found that Photoshop offers the best bicubic interpolation of any other software that I have compared.


	
	
	

	


Resample
In graphics software, the resample command is used to increase or decrease the size and/or resolution of a bitmap-based image. An image is upsampled to increase the resolution by adding new pixels. An image is downsampled to decrease the resolution by throwing out pixels. 
Resampling an image usually results in a loss of image quality because pixels must either be interpolated or thown out. The exception is when the resolution of an image is changed without modifying the pixel dimensions. For example, an image with pixel dimensions of 1200 by 1600 can be printed at a size of 4 x 5.3 inches at 300 dpi or at 8 x 10.6 inches 150 dpi. Reducing the resolution while increasing the print size does not result in image destruction, but it will result in a loss of print quality. 
Anti-aliasing 
Anti-aliasing is a technique of blending bitmap-based images and text to reduce the stair-stepping or jagged appearance. In areas of transition, the edge pixels are blended to give a smoother appearance. Most software provides anti-alaising as an option when placing text or objects in a bitmap-based image, however, anti-aliasing should be disabled when very small type is used under 8-10 points. 
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Understanding Digital Color Diagram Link

RGB 
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One of the color spaces used in graphics software. This color space is based on the primary additive colors of R ed, G reen, and B lue. This is the most common color mode used in graphics software. In general, it is best to edit your images in RGB color mode because many software features and commands will not be available in CMYK mode. Converting your RGB images to CMYK should be one of the final steps before sending your image to a commercial printer (Also see Out of Gamut ). Although your inkjet printer may use these four colors of ink, you do not need to convert images to CMYK for printing on consumer-level desktop inkjet printers. In the case of desktop printers, the RGB to CMYK conversion is handled by your printer driver.
CMYK
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Representation of a photographic image with CMYK channels or seps for 4-color process printing.Image © J. James To reproduce full-color photographic images, typical printing presses use 4 colors of ink. The four inks are placed on the paper in layers of dots that combine to create the illusion of many more colors. CMYK refers to the 4 ink colors used by the printing press -- the the subtractive primaries plus black. 

C is cyan (a blue-green color), M is magenta (a reddish pink color), Y is yellow, and K is a pure black ink, the key plate or keyline color. 

A mistake often made when submitting artwork for 4-color printing is not converting the images to the CMYK color space. This is needed so that the file can be separated into the four colors (see example) so that a separate printing plate can be made for each of the colors. Also Known As: 4-color | process colors

The illustration on this page shows a color photograph (center) separated into its CMYK components. A separate plate for the printing press would be made from each one. Those areas on the C plate, for example, that are black and shades of gray would print in varying shades of Cyan. The white areas get no Cyan. Each ink is added in turn to create the final full color image on paper.
Graphics File Formats: In a nutshell: When to use what format? 
* If the images are for the Web or online, use JPEG, PNG, or GIF. 
*If the images are for print, use TIFF. 
* If you want to keep a version that remains editable, choose your software's native file format. (PSD for Photoshop, PSP for Paint Shop Pro, CPT for Corel Photo-Paint, etc.)
Common Graphics File Formats 

JPEG - JPEG (or JPG) (Joint Photographic Experts Group) If the images are for the Web or online, use JPEG, PNG, or GIF. JPEG is best for photos when you need to keep the file size small and don't mind giving up some quality for a significant reduction in size. JPEG is not suitable for images with text, large blocks of color, or simple shapes, because crisp lines will blur and colors can shift. 

TIFF – (Tagged Image File Format) is good for any type of bitmap (pixel-based) images. TIFF produces large files, but there is no loss in quality (lossless). TIFF also preserves layers, alpha transparency, and other special features when saved from Photoshop. The type of extra information stored with TIFF files varies in different Photoshop versions, so consult Photoshop's help for more information. 

PSD, PDD - PSD is Photoshop's native format. Use PSD when you need to preserve layers, transparency, adjustment layers, masks, clipping paths, layer styles, blending modes, vector text and shapes, etc. 

BMP - Use BMP for any type of bitmap (pixel-based) images. BMPs are huge files, but there is no loss in quality. BMP has no real benefits over TIFF, except you can use it for Windows wallpaper. 

PNG - (Portable Network Graphics) Use PNG when you need smaller file sizes with no loss in quality. PNG files are usually smaller than TIFFs, in my experience. PNG also supports alpha transparency (soft edges) and was developed to be a Web graphics replacement for GIF. Advantages of PNG images include: Lossless compression, 48-bit, true-color depth, varying levels of transparency, gamma correction, better compression, 10-30 percent smaller files than GIF, searchable content. Patent-free compression algorithm. 
GIF - Use GIF for simple Web graphics having limited colors. GIF files are always reduced to 256 unique colors or less and they make very small, fast-loading graphics for the Web. GIF is great for Web buttons, charts or diagrams, cartoon-like drawing, banners, and text headings. GIF is also used for small, compact Web animations.
To note: lossy data compression loses some data detail as it only allows an approximation of the original data to be reconstructed, in exchange for better compression rates. The term lossless means that no data loss occurs.
Histogram 
A histogram is a graph that depicts the tonal range of an image. The far left column represents 100% black pixels and the far right represents 100% white pixels, with all other tones spread in between. Most scanning software, photo editing software, and some digital cameras allow you to view an image's histogram. (Continued below...)

A histogram that shows more weight at the left of the graph represents a dark image, also called a low-key image. A histogram with more weight to the right of the graph represents a bright, or high-key, image. An image with a low-key histogram may be overexposed, and an image with a high-key histogram may be underexposed, though this is not necessarily always the case. Your eye--not a histogram--should always be your final judge. A histogram that shows a large flat area on either end of the graph, however, is most likely in need of some adjustment as you can see from the example below.
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The flag in this image is supposed to be white. It is clearly underexposed. The histogram makes it very obvious when you see the large flat area in the highlights portion of the graph. The histogram can also serve as a guide to let you know how much correction to apply.
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Most photo editing software has an Auto Color or Auto Levels command that can quickly fix these types of problems. Here Photoshop's Auto Color command was used and you can see the change to the histogram. With the majority of the graph weighted to the right, this is a fairly high-key image.
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This histogram of this image shows it is a low-key image, though the color and tone does not need correcting.
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Images that have been heavily edited often have spikes or gaps in the histogram such as the one shown here, taken from an artistically styled photo.

The histogram is just one tool which can be used in evaluating what kind of corrections may need to be done to an image. Use it as a guide, but don't let it become your sole focus.
Layers
 You can think of each layer in a document as a sheet of clear transparent film. When you paint on one of the sheets, you can still see through the unpainted areas of the sheet. When you stack the sheets, the painted areas on the lower sheets will show through the transparent areas of the sheets above. In Photoshop, the transparent portions of a layer are displayed as a gray and white checkerboard pattern (unless the image contains a background). The checkerboard pattern is not really part of the document; it's just there to help you identify the transparent areas.
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Take a look at the examples here. The large image shows the three layers stacked. The three smaller images show the contents of each layer. You can tell by the way the objects overlap that the fish is at the bottom of the stack, the butterfly is in the middle, and the star is at the top of the stack. Photoshop treats each layer as if it were a separate document so that any editing functions are only applied to the active layer.
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When you open an image such as a digital photo in Photoshop, normally the image opens with only a background layer. The background is a special layer that cannot have transparency and always remains on the bottom of the stack. When you stack additional layers above the background, the background will show through the unfilled portions of the layers above it. A background can be converted to an ordinary layer by double clicking on its name in the layers palette. You can type a new name for the layer at that time or accept the default. Naming your layers as you create them is a good habit to get into, because it helps you identify your layers in the layers palette more easily.
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In Photoshop, you use the layer palette for managing the layers in a document. Here's a screen shot of the layers palette for the example above. (I've enlarged the thumbnails for this screen shot so you could better see the layer contents.)

The layers palette shows you the stacking order of the various layers in your document along with a thumbnail to help you identify each layer at a glance. As mentioned previously, only a single layer can be edited at one time. The active layer will be highlighted in your layers palette. 
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In addition, the active layer will have a paintbrush symbol in the small square just left of the thumbnail. Double-clicking on a layer in the palette gives you access to layer styles, as well as some advanced blending options that we will not be discussing in this course. Unlike previous versions, renaming a layer in Photoshop 6 requires you to Alt/Option double click on the layer name.

You'll also notice a small eye icon [image: image15.png]


for each layer. Clicking on this icon lets you toggle the layer visibility on and off. This way you can temporarily hide a layer if it's in your way. Hiding a layer also prevents it from printing. You can easily hide or reveal several layers in a row by quickly swiping across the column of icons as you hold down the mouse button. To hide all layers except one, you can hold down the Alt/Option key as you click the eye for the layer you want to remain visible.

Although editing functions can only be applied to one layer at a time, there are a few functions which can be performed on a series of layers. For instance, moving layers, copying layers between documents, and aligning layers. To perform these functions, you will need to link the layers that you want to work with.
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To link layers to the currently active layer, you would click in the second square (left of the thumbnail) in the layers palette. A link icon will appear in the space to indicate that the layers are linked. As with the visibility icon, you can quickly link several layers by swiping across this column with your mouse. To unlink several linked layers with one click, you can Alt/Option click on the paintbrush icon for the active layer. We'll discuss moving, copying, and aligning layers more later.

[image: image16.png]


Now take a look at the bottom row of buttons on the layers palette. These icons allow you to (left to right) work with layer effects, add a layer mask, group layers into sets, create adjustment layers, create a new ordinary layer, and delete layers. For now we're only going to discuss the last two buttons.

If you click the delete layer button, you will be asked to confirm that you really want to delete the active layer. If you want to delete the layer without confirmation, you can drag the layer from the layer palette stack and drop it on the delete button.

When you click the new layer button, a new, empty layer is created above the currently active layer. The new layer will be given a name such as layer 1, layer 2, and so on. If you want to name the layer when you create it, hold down the Alt/Option key when you press the new layer button. To create a new layer below the active layer, hold down the Ctrl/Command key while pressing the new layer button. To create a new layer below the active layer and give it a name, use both modifier keys while pressing the button.

To quickly duplicate a layer, drag the layer from the layer palette stack and drop it onto the new layer button. The duplicate layer will have the same name as the layer being copied, with the word "copy" appended to it. If you want to give it a different name at the same time, you can hold down the Alt/Option key as you drag and drop the layer onto the new layer button.
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To change the stacking order of layers, you simply click and drag them into a new position in the layers palette. A thick line will appear to indicate where the layer will be placed when you let up on the mouse button (see screen shot at right).

Now let’s look at the options at the top of the palette.
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	More About Blend Modes

	• Blend Modes for Beginners
• Layer Blending Modes


Besides, working with blend modes is not something you can get a handle on by reading about. This is one of those things that you must experiment with. So, I strongly encourage you to set aside some time and visit the links in the sidebar to the right while you experiment and explore the blend modes. I've selected a variety of links because each one provides different explanations and example images and will give you a better overview of the range of effects you can achieve with blend modes. You can download this example image to your hard drive to use as you experiment. We'll learn some practical uses for many of the blend modes in future lessons.

[image: image54.png].Mww a



Next to the blend mode menu is the opacity control for the layer. 100% opaque means that there is no transparency to the layer. In the example shown here, I've adjusted the opacity of the star layer to 50%. Notice how the layers below show through. As you move the slider left, the layer will become more and more transparent until you get to the far left where the layer content disappears entirely.

You can control the opacity level using your mouse with the slider control, or numerically using the number keys on your keyboard. Tapping 1 on the keyboard sets the opacity to 10%, 2=20%, and so on up to 0 for 100%. For even more precision, you can tap two numbers in quick succession to set the opacity to a specific two-digit value, such as 75%.

Take some time to experiment with the stacking order and opacity controls using the example image.

The opacity setting controls the transparency of the layer overall, however, it is possible to have varying levels of transparency in a layer, even if that layer is set to 100% opacity. You do this using the painting tools, eraser, layer masks, and so on. Many of Photoshop's painting tools have their own opacity control that is independent of the layer opacity. I hope that last paragraph didn't confuse you too much, because the next option we'll be talking about is the transparency lock... and it really has the potential to confuse!

Below the blend mode and opacity controls, you have a series of checkboxes for locking various editing functions. From left to right the lock can be applied to:

· [image: image18.png]


transparency,

· [image: image19.png]


image pixels,

· [image: image20.png]


position, and

· [image: image21.png]


all of the above.
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When any of the locks are activated, you will see a small lock icon appear to the right of the layer in the layers palette. When all locks are activated, the lock icon will turn solid. You'll notice the background layer always has its transparency and position locked. This cannot be changed without promoting the background to a layer.
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The transparency lock allows you to edit on a layer without changing the transparency level of the pixels in that layer. The best way to explain this is with an example.
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In the image we've been working with, set the opacity of one of the layers to 50%.

Now pick a color (I used green) and fill the layer with that color.

Result = the entire layer is filled with the color giving the layer a 50% green tint in my case.


[image: image57.png]


Now undo that change and check the transparency lock. Fill the layer with your color again.

This time, only the layers where there were pixels are filled, and those pixels retain the same transparency values that they had before you filled the layer. 50%, in this case.

This transparency lock effects any type of editing you do on the layer, including painting, filling, and filters. For another experiment, try the gaussian blur filter with transparency unlocked, then undo and apply it again with the transparency locked.

The transparency lock isn't that difficult to understand, really, but it has the potential to really confuse you if you select it at some point and then forget that it's turned on! Whenever you encounter a tool or function that just doesn't seem to be behaving as it should, check to see if this or any of the other locks are selected before you panic.

[image: image23.png]


The image pixels lock disables all painting tools for that layer. You can still move and transform the layer contents, adjust opacity settings, and change blend modes, but you cannot paint directly on it.

[image: image24.png]


The position lock is self explanatory. You can't move or transform a layer that has its position locked, but you can still paint on it, apply layer effects, and change blend modes.

[image: image25.png]


And if you hadn't guessed already, the last lock is the same as selecting all three locks.

Masking: About layer and vector masks 

You can use masks to hide portions of a layer and reveal portions of the layers below. You can create two types of masks:

· Layer masks are resolution-dependent bitmap images that are edited with the painting or selection tools.

· Vector masks are resolution independent and are created with a pen or shape tool.

Layer and vector masks are nondestructive, which means you can go back and re‑edit the masks later without losing the pixels they hide.

In the Layers panel, both the layer and vector masks appear as an additional thumbnail to the right of the layer thumbnail. For the layer mask, this thumbnail represents the grayscale channel that is created when you add the layer mask. The vector mask thumbnail represents a path that clips out the contents of the layer.

Note: To create a layer or vector mask on the Background layer, first convert it to a regular layer (Layer>New > Layer from Background). 
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Masking layer
A. Layer mask thumbnail B. Vector mask thumbnail C. Vector Mask Link icon  D. Add Mask 

You can edit a layer mask to add or subtract from the masked region. A layer mask is a grayscale image, so areas you paint in black are hidden, areas you paint in white are visible, and areas you paint in shades of gray appear in various levels of transparency. 
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Background painted with black; description card painted with gray; basket painted with white

A vector mask creates a sharp-edged shape on a layer and is useful anytime you want to add a design element with clean, defined edges. After you create a layer with a vector mask, you can apply one or more layer styles to it, edit them if needed, and instantly have a usable button, panel, or other web-design element. 

The Masks panel provides additional controls to adjust a mask. You can change the opacity of mask to let more or less of the masked content show through, invert the mask, or refine the mask borders, as with a selection area.
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[image: image30.wmf]
Masks panel 
A. Select the filter mask. B. Add a pixel mask. C. Add a vector mask. D. Panel menu. E. Apply Mask

Channels: An image is basically a "channel sandwich" with one channel each for red, green and blue in an RGB image or cyan, magenta, yellow and black in a CMYK image. There would be 3 channels in an RGB image and 4 in a CMYK image to start with.
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Note: Channels are NOT the same as Layers.
1. If you open an RGB image and display the Channels palette you will see the red, green and blue channels plus an "RGB" channel. The "RGB" channel is only a composite of the three channels.

	RGB image...
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	Channels palette for RGB
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2. If you open a CMYK image and display the Channels palette you will see the cyan, magenta, yellow and black channels plus a "CMYK" channel. The "CMYK" channel is also just a composite of the four channels.

	CMYK image...

[image: image35.png]



[image: image36.jpg]




	Channels palette for CMYK
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Each channel in a true color image (RGB or CMYK) has an 8-bit color depth (for more data on color depth click here). An RGB image is composed of three 8-bit channels that combine to form a single 24-bit image (3 x 8 = 24). A CMYK image is composed of four 8-bit channels that combine to form a single 32-bit image (4 x 8 = 32).

Note: Each pixel in an RGB image has a color depth of 24 bits and each pixel in a CMYK image has a color depth of 32 bits.

3. By default, Photoshop displays channels in grayscale. You can also display the channels in color. Choose File > Preferences > Display & Cursors, then check "Color Channels in Color".

	Channels in color for RGB...
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	Channels in color for CMYK...
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Storing a Selection Mask as an Alpha Channel
When you make a selection mask in Photoshop, the mask is an 8-bit grayscale image. When you save a selection in the file, Photoshop has to put it somewhere, so it is stored as a channel. 
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You can try this yourself. First you need to make a selection with one or more selection tools.

4. In this example we'll use the Magic Wand Tool [image: image41.png]


and select the white background pixels. The "Anti-aliased" checkbox was checked in the Options palette. The selection marquee appears as a row of "marching ants".
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5. Now click Select > Save Selection and click OK in the dialog to save it. Photoshop will save the selection as a new channel by default.
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6. Now the Channels palette shows the new channel. Photoshop assigns the default name of "Alpha 1" to the new channel.
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7. Click the "Alpha 1" channel in the Channels palette.
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8. Now the document window will display the channel by itself.
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(For more basic terms please visit: Graphics Glossary)
:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

For Intermediate and Advanced Study:

Megapixels 
A megapixel, abreviated MP, is one million pixels, though this number is often rounded when referring to digital camera resolution. For instance, a 4 megapixel camera actually produces an image closer to 3.87 million pixels, and a 3 megapixel camera produces an image with 3.15 million pixels. If you know the maximum dimensions of the image you have, you can multiply the width times the height and divide by 1 million to get the megapixels.

1600 by 1200 pixels = 1,920,000 pixels = 1.92 MP. This is the size of an image from a 2 MP camera. 

Also Known As: mega-pixel MP 
Question: How Many Pixels Do I Need for Printing Photos?
Answer: Whether scanning a document or choosing a digital camera, many people are confused about how many pixels they need in an image. 

First, it's important to understand a few terms that relate to image size and resolution--PPI, DPI< and Megapixels. If you're not familiar with these terms, or you need a refresher, follow the links below for a more detailed explanation: 

Pixels per inch (ppi) - A measurement of image resolution that defines the size an image will print. The higher the ppi value, the better quality print you will get--but only up to a point. 300ppi is generally considered the point of diminishing returns when it comes to ink jet printing of digital photos. 

Dots per inch (dpi) - A measurement of printer resolution that defines how many dots of ink are placed on the page when the image is printed. Today's photo-quality ink jet printers have dpi resolution in the thousands (1200 to 4800 dpi) and will give you acceptable quality photo prints of images with 140-200 ppi resolution, and high quality prints of images with 200-300 ppi resolution. 

Megapixels (MP) - One million pixels, though this number is often rounded when describing digital camera resolution. 

When determining how many pixels you need, it all boils down to how you will be using the photo and what size it will be printed. Here's a handy chart to guide you when determining how many pixels you will need for printing standard size photos on an ink jet printer or through an online printing service. 

5 MP = 2592 x 1944 pixels
High Quality: 10 x 13 inches
Acceptable Quality: 13 x 19 inches 

4 MP = 2272 x 1704 pixels
High Quality: 9 x 12 inches
Acceptable Quality: 12 x 16 inches 

3 MP = 2048 x 1536 pixels
High Quality: 8 x 10 inches
Acceptable Quality: 10 x 13 inches 

2 MP = 1600 x 1200 pixels
High Quality: 4 x 6 inches, 5 x 7 inches
Acceptable Quality: 8 x 10 inches 

Less than 2 MP
Only suitable for on-screen viewing or wallet-size prints. See: How many pixels do I need for sharing photos online? 

Greater than 5 megapixels
When you get beyond five megapixels, chances are you are a professional photographer using high-end equipment, and you should already have a handle on the concepts of image size and resolution. 

Megapixel Madness
Digital camera manufacturers would like all customers to believe that higher megapixels is always better, but as you can see from the chart above, unless you have a large format ink jet printer, anything over 3 megapixels is more than most people will ever need. 

However, there are times when higher megapixels can come in handy. Higher megapixels can give amateur photographers the freedom to crop more aggressively when they can't get as close to a subject as they would like. But the trade-off to higher megapixels is larger files that will require more space in your camera memory and more disk storage space on your computer. I feel the cost of additional storage is more than worthwhile, especially for those times when you capture that priceless photo and may want to print it in a large format for framing. Remember, you can always use an online printing service if your printer can't handle large format. 

 What is a digital camera Raw file?
Answer: What exactly is RAW? You will find it amusing with all of the acronyms used with computers these days the RAW is not an acronym for anything. If you think of the traditional meaning of raw, which means something that is unprocessed, and in a natural condition then you will have no trouble remembering what a RAW image is: an image containing unprocessed data. Think of RAW as the digital equivalent to a photo negative. 
To understand exactly what makes up a RAW file, you first need to understand how most current digital cameras work. Sensors create an image from millions of light-sensing areas of a chip. Most sensors actually only record in greyscale values and then use filters and color schemes such as the Bayer Pattern (invented by a Kodiak scientist Dr. Bayer in the 1980's) to determine the colors. There are usually three different colors: red, green, and blue. 
• More on Camera Sensors 

RAW files are usually proprietary to the camera manufacturer and sometimes a specific camera model. That means that only the camera that captures the picture can understand the information collected on the sensors. The settings associated with them, such as the aperture, shutter speed, white balance, contrast, sharpening, and saturation values are not applied; they are stored for later use. RAW images are primarily used by professional photographers who require complete control over their image. 

Readers Respond: When shooting digital photos, do you prefer JPEG or Raw for your camera files?

Read responses (9) Share Your Reasons
Digital Camera Resources

· Top Digital Camera Newbie Mistakes to Avoid
· About Digital Cameras
More About RAW Files

· Raw or JPEG? Should You Capture Digital Photos In Raw or JPEG Format? 
· Working in the RAW: What Happens in Your Camera
· Raw image format on Wikipedia
Helpful info for Digital Photography Basics:
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